MassGIS Data Viewer Utilities Extension Documentation - 10/17/99

The MassGIS Data Viewer Utilities Extension is an extension developed for MassGIS by Applied Geographics in the summer of 1999.  The extension provides several types of additional functionality to the basic MassGIS Data Viewer:

· Display of all 3 menus of the 3-tiered menu structure at once, so

that it is easier to find a theme. 

· An interface for editing the MassGIS Data Viewer’s themeinv.dbf, zoominv.dbf, inquiry.dbf and joinlink.dbf tables (which govern the “A” and “Z” buttons)

· The ability to create additional “user” themeinv.dbf, zoominv.dbf, inquiry.dbf, and joinlink.dbf equivalent tables.

· The ability to easily add new, formatted themes from the View into

these MassGIS or user tables.

Requirements to use the extension:

The extension will work with either ArcView 3.2, ArcView 3.1.1 or ArcView 3.0a on either Windows or UNIX.  If using ArcView 3.0a, be sure to first load the ArcView Dialog Designer extension first.

NOTE: Some minor changes or fixes may be made in the near future.  If you experience problems using this extension please email gis.viewer@state.ma.us.  Please mention the Data Viewer Utilities extension explicitly in your message.  Also state which operating system you are using (i.e. Window 98, NT, Mac, UNIX), and which version of ArcView.  This information will help MassGIS staff evaluate your problem.
How to add the MassGIS Data Viewer Utilities Extension to the MassGIS Data Viewer project session:
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Make the project window the active window.  Choose the File menu, then the Extensions menu.  Click a check mark next to the “MassGIS Data Viewer Utilities” extension.  If you do not see the extension in the list, copy the agi-massgis.avx file to either your c:\temp directory, or the directory where your ArcView extensions are stored (the ext32 directory, usually in a path similar to c:\esri\av_gis30\arcview).  Two new buttons and one menu (“MassGIS”) will be added to the Project.


The two additional buttons on the button bar to the right of the “A” and “Z” buttons can be considered “enhanced” “A” and “Z” buttons.
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  This button, with the image of datalayers being added, is the enhanced “A” button.

[image: image2.bmp]  This button, with the image of 2 arrows, signifying zooming to a particular geographic area, is the enhanced “Z” button.

These buttons are enhanced versions because, instead of popping up one at a time the 3 tiers of menu choices, all menu choices are presented at once in a 3-column format.  Also, these buttons provide access to editing features that will allow editing of the underlying tables that the buttons use.  (These tables are the same ones that the “A” and “Z” use.)  Previously, to edit the “A” and “Z” tables, the user had to bring the table into ArcView and edit it manually.  Through these new buttons, dialog box interfaces are presented to prompt the user for the information to enter.  

Using the Extent Tool for extent selection: [image: image3.bmp]
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Clicking on this button will bring up a dialog box such as the one above titled “MassGIS Extent Viewer”.  (The type of access is also displayed in the title bar.  In the above example the user has general access to add/delete/edit extents.  This is one of the 2 possibilities – general access, or administrator access.  Editing will be covered in a separate section below.)  This is the typical MassGIS Data Viewer “Z” button 3 menus shown in 3-column format. Normally when the “Z” button is clicked, one menu appears.  A selection is made from this menu and a second menu appears.  A selection is made from this menu and the third and last menu appears.  The disadvantage is that the choices underneath the first two menus cannot be seen at once.  The cancel button can be used to bring back the previous menu, but this is somewhat awkward.  In this extension all 3 menus are shown horizontally.  When a choice from the first column is selected, columns 2 and 3 adjust accordingly to show consistent choices.  To zoom to an extent, select a choice in the third column and click on the large “Zoom View to Extent” button. (Alternatively, the user may double-click on the choice in the third column.  If the third column contains only once choice, double-clicking on the choice in the second column will also work).

The drop-down box in the upper right hand corner holds 3 choices.  Zoom to “an extent” was described above.  If Zoom to “a Point” is pulled down, a dialog box will appear prompting for point input in a variety of coordinate systems.  When the data is entered and the “Zoom to a Point” button is clicked the point will be projected into MassGIS standard NAD83 MA state plane meters and a graphic will appear in the View.  The View will be recentered on the graphic point.  (Note: for latitude and longitude, the negative sign for longitude should not be entered.)
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If Zoom to “a USGS Location” is pulled down, a dialog box will appear prompting for text of a place.  Any non-road text appearing on a USGS topographic map can be searched for.  The text searching is not case-sensitive (meaning that the text can be entered with or without capital letters).  After entering the text, either hit return or click on the large button “Zoom to a USGS Location”.  Note, only the area of the view will be searched.  If a match is found, the View is zoomed in to within one mile of the point.  (No graphic point is created).  If more than one match is found a list is presented for selection.  If the text is contained the name of a feature, that feature will also be included in the list.  (i.e. a search for “Mill Pond” will also return “Little Mill Pond”.)  If no match is found the place may not be in the geographic area of the view.  Consider zooming out to the extent of the entire state and searching again.  If no match is found at this extent then the text is not in the database.
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These two choices have been available under the “Z” button as “Enter Point” and “USGS Feature.”

Using the Theme Tool for theme selection: [image: image7.png]
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Clicking on this button will bring up a dialog box titled “MassGIS Theme Viewer”.  This dialog box can be open at the same time that the MassGIS Extent Viewer is open.  This is the typical MassGIS Data Viewer 3 menus rolled into one.  Normally when the “A” button is clicked, one menu appears.  A selection is made from this menu and a second menu appears.  A selection is made from this menu and the third and last menu appears.  The disadvantage is that the choices underneath the first two menus cannot be seen at once.  The cancel button can be used to bring back the previous menu, but this is awkward.  In this extension all 3 menus are shown horizontally.  When a choice from the first column is selected, columns 2 and 3 adjust accordingly to show consistent choices.  To add a theme to the active View, select a choice in the third column and click on the large button “Add Theme(s) to a View”.  (Alternatively, double-click on the choice in the third column. If the third column contains only once choice, double-clicking on the choice in the second column will also work.)  When a theme is active, such as the Capped Landfills theme above, the title bar will indicate the type of data (polygon, in this case), and the themeid number of the theme (409 above).  In the case of theme maps, the list of themeid numbers will be indicated.

The use of the extension for adding themes or zooming to an extent, as described above, is identical to the use of the “A” and “Z” button – the presentation is just a little nicer.  The description of the editing capabilities of the extension follows.  Before reading about the editing capabilities it is recommended that the user familiarize themselves with the structure of the tables behind the “A” and “Z” buttons by reading the document “developr.doc” (or .txt) found on the MassGIS web site: http://www.state.ma.us/mgis/vwr_dnld.htm (download the docs.exe at the bottom of the page.)

Using the tools for EDITING the tables: 

There are two ways to use the editing capabilities of the extension.  One is to add a completely new theme (or extent) to the tables.  Another is to edit currently existing themes (or extents).  To display the editing tools for either extents or themes, logging in is required.  One may log in either as administrator or as non-administrator.  As administrator editing the MassGIS tables (themeinv.dbf, inquiry.dbf, zoominv.dbf, joinlink.dbf) is allowed.  As non-administrator, only editing of other user-created tables is allowed.  The password to become administrator is simply “administrator”.  The password for non-administrator is any word that is NOT “administrator”.  

To log in and unlock the editing tools:

For either the extent or theme dialog, click on the open folder button in the upper right hand corner.  In the dialog box that appears entitled “Extent (MassGIS) Settings” or “Theme (MassGIS) Settings”, click on the down arrow and choose the menu choice “Unlock/Lock Edit Tools”.  Then click the OK button.
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You will be prompted to log in.  If you are not prompted to log in, choose Reset All, then “No”, then choose “Unlock/Lock Edit Tools” again.  Type either “administrator” to be able to edit the MassGIS tables, or type any other text string to only be allowed to edit your own tables. (As a safeguard you may want to avoid logging on as administrator unless necessary).  The type of access that you currently have is noted in the upper right hand corner of the dialog box.  Either ADMIN access for administrator, or General access for non-administrator.  To switch to the other type of access, repeat the above and lock the tools, then unlock them again and type in a different password.  When the tools are unlocked they will appear on the toolbar to the right of the large “Zoom View to extent” or “Add Theme(s) to a view” buttons.  The tools displayed for the extent and theme dialogs are slightly different.
Extent Editing:

To Add a new extent to the tables:  [image: image10.png]



One of the most common actions desired will probably be adding new extents.  The MassGIS Data Viewer Utilities extension is set up so that the new extent’s geographic values will be automatically inserted into the dialog box.  In the View, zoom to the extent to be saved.  Click on the button with a picture of a globe.  A new dialog box will appear, entitled “Preserve a Geographic Extent…”   First, a table to store the extent in must be selected. The options for which table the extent can be stored in (the Dbase dropdown box at the upper right) depends on how you are logged in.  If you are logged in as administrator, the choices will include a table called zoominv.dbf.  If you are not logged in as administrator, the choices will not include zoominv.dbf.  You need to choose a user table, such as ext_us1.dbf.  Any files in the directory where the viewer project (av30mg2.apr) resides starting with ext_ will be considered extent tables and be read into memory.  Once a destination table has been selected, choose the menu1, menu2, and menu3 titles that you wish the extent to be stored under.  The default menu1, menu2, and menu3 values are those of the currently selected extent in the MassGIS Extent Viewer dialog.  The extent numbers themselves can also be edited if necessary.  The default is that the numbers cannot be edited until the “Edit XY Values” box is checked – to prevent accidental number editing.  The path shown in the lower left hand corner of the dialog box indicates where the extent table is stored.  When you are done setting the parameters for the extent, click the large button at the bottom entitled “Save this Extent.”  If you wish to exit without saving the extent, click on the button at the bottom entitled “Cancel.”  After the extent is added to a table, the extension will automatically re-read the extent tables into memory (in previous “A” and “Z” button table editing, this is equivalent to the View menu’s Reset the Project menu choice), and the new extent will appear in the MassGIS Extent Viewer dialog.  

To Edit existing extents in the tables:

Existing extents may be deleted or modified.  

The delete button  [image: image11.png]


 is the scissors image.  When an extent is highlighted in the MassGIS Extent Viewer dialog, the scissors button will be greyed out if your current login status is insufficient to delete that extent.  For example, if you are not logged in as administrator you will not be able to delete extents from the MassGIS zoominv.dbf table.  If you are logged in as administrator you may delete extents from any extent table.  NOTE: Information about which table the extent is stored in is available in the ArcView message bar in the lower left hand corner of the ArcView screen when your mouse cursor is hovering anywhere over the MassGIS Extent Viewer dialog. Simply make an extent active in the MassGIS Extent Viewer dialog, click on the scissors button and the extent will be deleted from the relevant table.  (Actually, you will be prompted to confirm: 
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More than one extent may be deleted at one time – simply made more than one extent active.  All extent tables will be reread into memory and your deletion should be implemented.  

The edit button [image: image13.png]


 is the spectacles image.  This button is never greyed out.  When you click on this button a dialog box will appear entitled “Geographic Extent Parameters.”

[image: image14.png]Use tis menu to ecit the parameters of the
selected Save Map Extent,

Pinay Tile [N

Seconday Tile [Testt

Thid Title [0 the Cape -pat

| RMin TRTEEL AT X Max 06693.669
4
¥ Min 7E334.216 ¥ Max 23173
Widh: 46311.428 Height: 40678.957

d\ogi101389%en_usT. bl

Save Changes. Cancel





The button is never greyed out because even if you do not have permission to edit the selected extent, you might want to view the parameters.  If you do not have permission to edit the parameters you will not be able to type into any of the boxes, and the “Save Changes…” button will be greyed out.  The Primary Title, Secondary Title, and Third title are the Menu1, Menu2, and Menu3 columns.  The X Min, Y Min values are the lower left hand corner of the extent.  The X Max, Y Max values are the upper right hand corner of the extent.  The path in the lower left hand corner of the dialog box is the table in which this extent is saved.

The Build Extents from Data Features button [image: image15.png]


 is another way of adding extents – this time in batch mode (which means that you can add a whole bunch at once).  This button will take selected features from a theme in the view and calculate their extents.  In this example, I will create a new set of extents for towns with names starting with “U”.
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The default 3 menu choices are from the currently selected extent in the MassGIS Extent Viewer dialog.  Edit these choices to reflect where you wish the new extents to be saved.  Choose a theme from the View.  Above is MA Towns.  Next, choose a field from that theme.  I chose Town, which is the town name field.  The values for that field will appear in the list in number 5.  I chose to select only 2 records in the list – towns that start with the letter “U”.  Number 6 is optional – if you want to “back out” of your extents to add a margin, type a scale factor into this box.  Otherwise, the extents will be created exactly as if the feature was selected and the Zoom to the Extent of the Selected Features button was used in ArcView.   When all parameters are set, click on the “Create Extents Now” button.  The extents will be entered into the table, and the tables will be reread. (note:  If there are multiple extent tables to which you have permission to write, you will be prompted to specify the table.  If you are logged in as administrator and the only possible extent table in the project where the Data Viewer is saved is zoominv.dbf, the extents will be saved to this table.  If you are not logged in as administrator, and only one ext_ named table is in the directory where the Data Viewer project is saved, the extents will be saved to this ext_ named table.)  The MassGIS Extent Viewer dialog will be updated:  
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The Select and Save Extent tool [image: image18.png]


 looks like the regular ArcView selection tool. It allows and extent to be saved by drawing a box with the mouse manually.  After depressing this tool, move the mouse to a View and draw a box.  This box is the extent you wish to save.  The “Preserve Geographic Extent…” dialog will pop up.  This is the same dialog that was mentioned above in the section called “To Add a new extent to the tables.”  

The Add Extent Graphics button [image: image19.png]


 will add a graphic to the current view.  It will add a red outline box to symbolize the extent of the current, selected extent in the MassGIS Extent Viewer dialog.  A view with an extent delineated is often useful as a locus map or overview on a layout.  These graphics can be selected and deleted just like any other graphics in ArcView.  Using the active extent above (the town of Upton), the result of the Add Extent Graphics button is shown below (I zoomed in for a clearer view).
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Other extent choices:
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After clicking the open folder button on the main MassGIS Extent Viewer dialog, under the down arrow are two other choices.  You can create a new extent table independently of any other action, and you can reset the extent inventory (reread the tables into memory) independently of editing the tables.  If your edits do not show up in the MassGIS Extent Viewer dialog, try resetting the Extent Inventory manually.  


Theme Editing:

To Add a new Theme to the tables:
Overview:

The extension is set up so that the theme’s properties will be automatically added to the tables in the appropriate places.  Therefore, if the theme name, scalemin and scalemax, and table properties have been altered manually in ArcView (through Theme Properties, for example), these customizations will be preserved.  The extension is designed to make it easy to add new themes to the tables.  (Previously, tables had to be edited by hand.)  Every theme must have a record in the themeinv.dbf table (or a user version of this i.e. inv_*.dbf).  Every theme may have records in the inquiry.dbf (or als_*.dbf) table and joinlink.dbf table (or lnk_*.dbf).

Step by Step:

Create a new theme in the view.  Symbolize the theme and create a name for the theme in Theme Properties.  In Theme Properties set a scalemin and scalemax.  Open the feature attribute table of the theme and hide certain fields or rename fields.   When the theme is customized completely the way you like it, then it is ready to be added to the tables.  Click on the open folder button in the upper left of the MassGIS Theme Viewer dialog box.  Click on the down arrow and choose the Unlock/Lock Edit tools choice.  A password dialog box will appear.  If “administrator” is entered all tables will be editable – including the MassGIS tables (themeinv.dbf, inquiry.dbf, joinlink.dbf). If any other word is entered as the password additional tables can be created but editing the MassGIS tables will not be allowed.  The type of access currently in place is noted in the upper right hand corner of the dialog box.  One advantage to creating user versions of the tables for user themes is that when MassGIS distributes updated copies of the MassGIS tables the old MassGIS tables can be swapped for the new MassGIS tables easily.  Once the edit tools are unlocked, 4 new buttons appear in the dialog box.  
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One of the buttons is a plus button – familiar from the ArcView Add Theme button.  Clicking on this button initiates the process of adding the new theme to the tables.  This button will only be active if there is an active theme in the View.  If there is no active theme in the View the button will be greyed out.

When the plus button is clicked, a new dialog box will appear. 
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If the user is not logged in as administrator the new theme will have to be added to a separate table from the MassGIS themeinv.dbf table.  Notice that everything is initially greyed out except the Create New Database choice and the Cancel button.  Click on the first down arrow to Create New Database.  The file inv_in1.dbf is the default choice.  Any file starting with an inv_ is acceptable.  The file should remain in the directory that the ArcView project is in.  Once a new database is created the controls become active and values can be filled in. 
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The default themeid starts with 1000 for a new, non-themeinv.dbf table (because the MassGIS themeinv.dbf is currently has themeids < 1000).  Otherwise, the themeid will be the first available themeid number that is not active.  You may still want to edit this number to be one more than the largest themeid in the table.  You will not be allowed to enter a number that is already being used in the theme inventory table that you are editing.  If the MassGIS themeinv.dbf table and a user table contain two themeids that match, the user table’s themeid will be internally renumbered for the purposes of the dictionary.  This is technically necessary.  

Enter in the Menu 1, Menu 2 and Menu 3 choices to be in effect for this new theme. (The default values are those for the currently active theme in the MassGIS Theme Viewer dialog).  The TOC (Table of Contents) Theme title is taken from the Theme’s Project Properties Theme Name.  The source is automatically filled in as well – however it is the absolute path to the data (you may want to edit it to include an environment variable, such as $TOWN for example).  A suggested name and location for the legend file is offered (you may wish to edit this path and name.  When you have completed the steps for adding a theme this legend file will be created.)  If you wish to quit without saving, click on the Cancel button.  If you have completed the values and do not have any attribute table choices or joins or links to include, click on the Done button.  The legend file will be created and the record for this theme will be added to your table.  The project’s dictionaries will be automatically recreated, so that the MassGIS Theme Viewer dialog box (as well as the standard “A” and “Z” buttons) will immediately reflect your new theme. (If the values are not reflected correctly click on the open folder button and choose the “Reset All…” menu choice – this explicitly will reread the tables.)  The MassGIS standard themeinv.dbf and your new table (i.e. inv_in1.dbf) are concatenated to create the values in the MassGIS Theme Viewer dialog.

If your new theme also has attribute table customizations, however, click on the Continue button instead of the Done or Cancel buttons to move to the next dialog box.
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This dialog box lets you create records in your version of the inquiry.dbf table.  First you need to create a new database – click on the down arrow in the middle of the screen and choose “Create a New Database”.  The default file name is als_in1.dbf.  This file needs to start with als_ (for alias) and be stored in the directory where your Data Viewer project resides.  Next, choose a field from the Available Theme Fields drop down box in the upper right.  These are all the fields in the feature attribute table of the theme.  If the feature attribute table of the theme is joined to another table, the joined fields will also appear in the list.  Any fields that you do not choose will be visible as default.  Fields that you do list in list dialog box can be edited for visibility (Y/N), whether it is a label field (L) – L is also visible, and for a Field Alias.  Field Aliases can rename obscure variable names such as avghhinc to meaningful words such as “Average Household Income.” The values for the fields that you choose are supplied from any pre-defined Table Properties values.  In other words, if you’ve set up the table manually, just add the fields and click Done.  If you have done no feature attribute field table customizations through ArcView but would like to – use this dialog box.  More than one field may technically be able to be listed as a Label field, but the Data Viewer code will only recognize the first one.  So, limit yourself to one label field.  Field aliases may contain spaces and other nonalphanumeric characters.  If you have no join or link events to set up, click the Done button and the MassGIS Theme Viewer dialog should refresh and add your theme.  The next time that you add this theme (whether through the standard “A” button, or through the MassGIS Theme Viewer dialog), the theme’s feature attribute table should have the appropriate customizations.  If you have join and/or link events to set up, click on the Continue button to move to the dialog entitled “Step 3… Join/Link Events” will appear. 
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The first thing to do is choose a table to store the join/link events.  The default if you are not administrator is a table beginning with lnk_ .  After you select a table, click on the plus button and either choose a table or type in “Attributes of TOCThemeTitle ”.  To explain, if you would like to join or link a table to the Feature Attribute table of the theme that you are adding you cannot simply search the hard drive for the table (i.e. newtheme.dbf).  You must type in the text string “Attributes of TOCThemeTitle”, where you substitute for the italized ThemeLabel the TOC Theme Title of your theme.  In the above example, my TOC Theme Title is The Animals, so I would enter “Attributes of The Animals”.  Next, type in the Field that you will use to match up the tables.  In the second database box, choose the second table you wish to use in your link or join.  Either .dbf or INFO tables can be chosen for these databases.  If a table button appears, [image: image27.bmp], you can click this to add the table to the project.  Then, a [image: image28.bmp] button will appear to the right of the Field box.  You can click the button to obtain a list of the fields in that table.  Choosing a field will enter it into the Field box.  Once the two tables are chosen you can specify the relationship between them.  Tables may be joined, linked, or queried.  Sometimes a combination of these options is available.  Examine the MassGIS joinlink.dbf table’s solid waste themes for some complex examples.   Also read the developr.doc (or .txt) documentation file on joinlink.dbf table structure for more information.  Some quick scenarios to show the possibilities:  A table can be linked to the feature attribute table.  A table can be joined to the feature attribute table.   Two tables unrelated to the theme can be joined, and then linked to the feature attribute table.  A table can be queried, and then backward linked to the feature attribute table (to show a subset of polygons, for example).  If a themeid is listed more than once in the joinlink.dbf (or a user – equivalent lnk_*.dbf), each record is processed in turn.  

To Edit existing themes in the tables:

Existing themes may be deleted or modified.  

The delete button  [image: image29.png]


 is the scissors image.  When a theme is highlighted in the MassGIS Theme Viewer dialog the scissors button should be greyed out if your current login status is insufficient to delete that theme (if may not be greyed out even if you do not have permission to delete the theme – If you try to delete it, however, you will be told that you do not have permission).  For example, if you are not logged in as administrator you will not be able to delete extents from the MassGIS themeinv.dbf table.  If you are logged in as administrator you may delete extents from any tables beginning with inv_  . NOTE: Information about which table the theme is stored in is available in the ArcView message bar in the lower left hand corner of the ArcView screen when your mouse cursor is hovering anywhere over the MassGIS Theme Viewer dialog. (So much information is displayed for themes that the table the extent is stored in may not be readable.  MassGIS will tinker with this).  Simply make a theme active in the MassGIS Extent Viewer dialog, click on the scissors button and the theme will be deleted from the relevant table.  Actually, you will be prompted to confirm:


More than one theme may be deleted at one time – simply made more than one theme active.  All theme tables will be reread into memory and your deletion should be implemented.

The Edit button [image: image30.png]


 is never greyed out.  This is because you may want to examine the parameters for a theme without editing them.  If a theme is selected in the MassGIS Theme Viewer dialog which you do not have access to edit, the parameters values in the Editing ThemeID dialog will not be editable and the title bar will include the text “(Read Access Only)” as opposed to “(Read/Edit Access)”.  (Note:  The source files of librarian themes i.e. cape.cpsvwell are not detected correctly and a message “Unable to find this source file” will appear in the Editing ThemeID dialog.  Please disregard it for now.  MassGIS will try to improve this as well.)

The Duplicate button [image: image31.png]


 allows a theme to be duplicated.  This button will be greyed out if the active theme in the MassGIS Theme Viewer dialog is not one for which you have write access (This doesn’t make a lot of sense, since copying doesn’t edit the theme copied.  MassGIS will try to improve this).  This is useful if you want to create a new theme that has only slightly different parameters from an existing theme (for example, you want to add a new theme which only has a different symbolization (legend file) from the existing theme.  In this case you could duplicate the theme and then only need to edit the legend field and legend file name parameters.  Clicking on this tool creates a new theme with the same parameters are the theme copied, EXCEPT that the Menu 3 name has a .1 appended (or a higher number if necessary).  The new theme will appear in the MassGIS Theme Viewer dialog, and it will be selected.  To edit this theme simply click on the Edit tool. [image: image32.png]


 and the Editing ThemeID dialog will pop up.  

Other theme choices: 

After clicking the open folder button on the main MassGIS Theme Viewer dialog, under the down arrow are several other choices.  You can create a new theme inventory table, inquiry (alias) table, or joinlink table independently of any other action ( the Create a new Alias Database should read als_*.dbf, not alx_*.dbf) , and you can reset the theme inventory tables, inquiry (Alias) tables, or joinlink tables (reread the tables into memory) independently of editing the tables.  If your edits do not show up in the MassGIS Theme Viewer dialog, try resetting the Theme Inventory or all the tables (Reset All…) manually.
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Other errata not mentioned above on the “to fix” list:  

When trying to edit the source field in the "Step 1: Add Theme to Inventory" dialog box,

error occurred: "The script AGI/TMT (MassGIS) AddDataToInventoryDialog.SourcePathTextLine.Changed could not be found."

Step 2 when adding a theme should not talk about Join/Link events - it should talk about Field Parameter events.

When deleting themes from the theme inventory table, it is important to note that the corresponding themeid records in the corresponding alias table and joinlink tables are not deleted.  You must open these tables in ArcView and delete these records manually, and then reread the tables manually (Click on the open folder button on the MassGIS Theme Viewer dialog, and choose “Reset All…”.  This will hopefully be improved in the future.
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